NEC EXPRESSCLUSTER X 3.x for Windows SQL Server 2014 Quick Start Guide

Document Number ECX-MSSQL2014-QSG, Version 1, January 2015
Copyright © 2015 NEC Corporation.

Information in this document is subject to change without notice. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of NEC Corporation.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. Other system names, company names, and product names are trademarks and registered trademarks of their respective companies.
Disclaimer

The contents of this document are subject to change without notice. NEC Corporation assumes no responsibility for technical or editorial mistakes in or omissions from this document. To obtain the benefits of the product, it is the customer's responsibility to install and use the product in accordance with this document. The copyright for the contents of this document belongs to NEC Corporation. Copying, altering, or translating this document, in full or in part, without the permission of NEC Corporation, is prohibited.
# Table of Contents

About this Guide ........................................................................................................ 6
  Using this guide ........................................................................................................ 6
  Where to go for more information ........................................................................... 7

1  Overview .................................................................................................................. 8

2  System Requirements and Planning ......................................................................... 9
  1.1 SQL Server 2014 requirements .......................................................................... 9
  1.2 System Planning .................................................................................................. 10

2  Base System Setup .................................................................................................. 11
  2.1 Setup the Primary Server (Machine 1) ............................................................... 11
  2.2 Setup the Standby Server (Machine 2) ............................................................... 12

3  Microsoft SQL Server 2014 Installation ................................................................. 13
  3.1 Installing SQL Server 2014 on Primary Server ................................................... 13
  3.2 Installing SQL Server 2014 on Standby Server ................................................... 13

4  EXPRESSCLUSTER X Server Installation ............................................................... 14
  4.1 Install EXPRESSCLUSTER X on the Primary Server (Machine 1) ....................... 14
  4.2 Install EXPRESSCLUSTER X on the Standby Server (Machine 2) ....................... 14
  4.3 Restart the Primary and Standby Servers (Machines 1 & 2) ............................... 14

5  Base Cluster Setup ................................................................................................ 15
  5.1 Install Java Runtime Environment (JRE) .......................................................... 15
  5.2 Start the cluster manager .................................................................................... 15
  5.3 Create a cluster .................................................................................................. 15
  5.4 Create a failover group ....................................................................................... 15
  5.5 Create floating IP and mirror disk resources ...................................................... 16
  5.6 Upload the cluster configuration and initialize the cluster ................................. 16

6  Microsoft SQL Server 2014 Cluster Setup ............................................................ 19
  6.1 Moving the Master and Resource Database to Mirror Disk on Primary Server .. 19
  6.2 Configure SQL Server 2014 on the Standby Server ........................................... 20
  6.3 Create a SQL Server 2014 database on the Primary Server .............................. 20
  6.4 (Optional) Run Query Analyzer to test your database on the Primary Server ... 20
  6.5 (Optional) Run Query Analyzer to test your database on the Standby Server .. 20
  6.6 Set the SQL Server Services ............................................................................. 20
  6.7 Cluster Services Setup ....................................................................................... 20
  6.8 (Optional) Set up SQL Server monitor resource .............................................. 21
About this Guide

Using this guide
This guide provides a hands-on “Quick Start” set of instructions for the EXPRESSCLUSTER X (ECX) for Windows. The guide assumes its readers to have Windows system administration knowledge and skills with experience in installation and configuration of Microsoft Windows operating systems, networks, and SQL Server 2014. The guide includes step-by-step instructions to install and configure EXPRESSCLUSTER X with SQL Server 2014.

This guide covers the following topics:

Chapter 1:  Overview – describes the general steps of setup procedure.

Chapter 2:  System Requirements and Planning – describes the overall system and network requirements and includes a set of tables for planning the installation and configuration.

Chapter 3:  Base System Setup – describes the configurations required for each system before installing target application.

Chapter 4:  Microsoft SQL Server 2014 Installation – describes the installation procedure for SQL SERVER 2014 on the Primary and Standby Servers.

Chapter 5:  EXPRESSCLUSTER X Server Installation – describes EXPRESSCLUSTER installation procedure on the Primary and Standby Servers.

Chapter 6:  Base Cluster Setup – describes required configuration to enable full cluster functionality.

Chapter 7:  Microsoft SQL Server 2014 Cluster Setup – describes the configuration steps to include Microsoft SQL Server 2014 in the EXPRESSCLUSTER cluster.

Chapter 8:  Final Deployment in a LAN Environment – describes steps to verify the cluster and complete the deployment on a Primary and a Standby server.

Chapter 9:  Common Maintenance Tasks – describes how to perform common maintenance tasks using the EXPRESSCLUSTER Manager.
Where to go for more information

Refer to additional documentation under the "documentation" directory on the EC X distribution CD.

For more information, go to: http://www.nec.com/expresscluster

Other EC X guides are at:

- **Getting Started Guide** – General cluster concepts and overview of EC X functionality.
- **Installation and Configuration Guide** – EC X installation and configuration procedures.
- **Reference Guide** – Commands for EC X scripts and maintenance commands to execute from the command prompt.

Contact: info@expresscluster.jp.nec.com
1 Overview

The general procedure of Microsoft SQL Server 2014 with NEC EXPRESSCLUSTER X on two server machines (Primary and Standby) for high availability of Microsoft SQL Server 2014 consists of the following major steps:

1. Perform system planning to determine requirements and specify configuration settings prior to start of actual system installation and configuration.
2. Prepare the Primary and Standby Servers including OS installation and configuration if necessary.
3. Install, configure, and verify Microsoft SQL Server 2014 on the Primary and Standby Servers respectively. If an existing production Microsoft SQL Server 2014 system exists already then it could be used as the Primary Server without reinstallation of SQL Server 2014.
4. Install and configure NEC EXPRESSCLUSTER Server on the Primary and Standby Servers.
5. Create and configure NEC EXPRESSCLUSTER failover group to enable continuous protection and automatic recovery for Microsoft SQL Server 2014.
6. Upload the configuration file on the server and start the cluster to complete the deployment.
## 2 System Requirements and Planning

### 1.1 SQL Server 2014 requirements
- SQL Server 2014
- .Net Framework 3.5
- .Net Framework 4.0

System Requirements
Machine 1: Primary Server
Machine 2: Standby Server
Machine 3: Test Client Machine

<table>
<thead>
<tr>
<th></th>
<th>Machine 1 Primary Server</th>
<th>Machine 2 Standby Server</th>
<th>Machine 3 Test Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>Pentium 4 – 3.0 GHz or better</td>
<td>Pentium 4 - 3.0 GHz or better</td>
<td></td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>4GB or more</td>
<td>512 MB or more</td>
<td></td>
</tr>
<tr>
<td><strong>Disk</strong></td>
<td>1 physical disk</td>
<td></td>
<td>1 physical disk with 1 GB or more space available</td>
</tr>
<tr>
<td></td>
<td>OS partition: 20 GB or more space available(to include the installation of SQL SERVER 2014)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cluster partition: Partition of 17MB or more, available for EXPRESSCLUSTER X management</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The same size for each server system</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data partition: enough partition space to store SQL Server 2014</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>OS</strong></td>
<td>Windows Server 2012 R2 (Standard or Enterprise) with latest update</td>
<td></td>
<td>Windows 7 or later</td>
</tr>
<tr>
<td><strong>Software</strong></td>
<td>Java 1.5 (or later) enabled web browser</td>
<td>Java 1.5 (or later) enabled web browser</td>
<td></td>
</tr>
<tr>
<td><strong>Network</strong></td>
<td>2 - 100Mbit or faster Ethernet network interface cards</td>
<td>1 - 100Mbit or faster Ethernet network interface card</td>
<td></td>
</tr>
</tbody>
</table>
1.2 System Planning
Review the requirements from the last section and then fill out the tables of the worksheet below. Use for reference in the following sections of this guide. See Appendix B: Example System Planning Worksheet.

Machine 1 Primary Server
Machine 2 Standby Server
Machine 3 Test Client Machine

Table 1: System Network Configuration

<table>
<thead>
<tr>
<th>Machine</th>
<th>Host name</th>
<th>Network Connection</th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Default Gateway</th>
<th>Preferred DNS Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Public: Interconnect:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Public: Interconnect:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Floating IP (FIP) addresses:
Web Management Console FIP: (1) ______________

Table 2: System OS and Disk Configuration

<table>
<thead>
<tr>
<th>Machine</th>
<th>OS</th>
<th>Disk 0 (OS Disk)</th>
<th>Disk 1 (Data Disk)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Boot Partition:</td>
<td>Cluster Partition:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Drive Letter: Drive Letter:</td>
<td>Drive Letter: Size (&gt;17MB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Size:</td>
<td>Size:</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Boot Partition:</td>
<td>*Data Partition:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Drive Letter: Drive Letter:</td>
<td>Drive Letter: Size:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Size:</td>
<td>Size:</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The size must be large enough to store all data files for SQL Server 2014 to meet current and expected future needs.

Table 3: System Logins and Passwords

<table>
<thead>
<tr>
<th>Login</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine 1 Administrator</td>
<td></td>
</tr>
<tr>
<td>Machine 2 Administrator</td>
<td></td>
</tr>
<tr>
<td>Machine 3 Administrator</td>
<td></td>
</tr>
</tbody>
</table>
2 Base System Setup

2.1 Setup the Primary Server (Machine 1)

1. If necessary, install required hardware components and a supported OS including any required service pack as specified in System Requirements and Planning.

2. Verify basic system boot and administrator login functionality and availability of required hardware components as specified in System Requirements and Planning.

3. Configure network interface names
   a. Rename the network interface to be used for network communication with client systems to Public.
   b. Rename the network interface to be used for internal EXPRESSCLUSTER management and data mirroring network communication between servers to Interconnect.

4. Configure network interface TCP/IP Settings:
   a. In the Network Connections window, right-click Public and then click on Properties.
   c. Click the Use the following IP address: option button.
   d. Type the IP address, Subnet mask, and Default gateway values (Refer to System Requirements and Planning).
   e. Click the Use the following DNS server addresses: option button and enter the Preferred DNS server address (Refer to System Requirements and Planning). Click OK. Click OK.
   f. Return to the Network Connections window. Right-click Interconnect and then click Properties.
   g. In the Properties dialog box, double-click Internet Protocol Version 4 (TCP/IPv4).
   h. Click the Use the following IP address: option button.
   i. Type the IP address and Subnet mask values (Refer to System Requirements and Planning). Click OK. Click OK.

5. Configure network interface binding order:
   a. In the Network Connections window, click on the Advanced menu tab, and click Advanced Settings (press the ALT key if the menu is not visible).
   b. On the Adapters and Bindings tab, under Connections: use the up and down arrow buttons to move Public to the first (top) position. Click OK.
   c. Close the Network Connections window.

6. Connect the network interfaces:
   a. Connect the network interface Interconnect to the Cluster Interconnect Network and verify a healthy physical link status.
b. Connect the network interface Public to the Public Network and verify a healthy physical link status and connectivity to the Management Console/Test Client (Machine 3).

7. Configure the Data Disk:
   a. Make sure the disk device or LUN is initialized as a Windows Basic disk device
   b. Create a mirrored disk cluster partition on the disk with specified size in Table 2 and make sure it is 17MB or greater. Assign drive letter specified in Table 2 to the partition but do NOT format it.
   c. Create a mirrored disk data partition on the disk with specified size in Table 2. Assign the drive letter specified in Table 2 to the partition and format it as NTFS file system.
   d. Verify the mirrored disk cluster and data partitions are visible in Windows Explorer under their respective assigned drive letters.

2.2 Setup the Standby Server (Machine 2)

Perform steps 1-7 in Setup the Primary Server (Machine 1) on the Standby Server
3 Microsoft SQL Server 2014 Installation

**If Microsoft SQL Server 2014 is preinstalled, skip section 4 and follow the guide from EXPRESSCLUSTER X Server Installation.**

3.1 Installing SQL Server 2014 on Primary Server

1. Insert the SQL Server 2014 disc into a disc drive.
2. Run Setup.exe.
3. Click on System Configuration Checker. Click on OK after reviewing the report.
4. Click on Installation in the left pane after all Global Rules have passed.
5. Click on New SQL Server stand-alone installation or add features to an existing installation.
7. Click on I accept the license terms. Click Next.
8. If failures were detected in Global Rules report, correct them before continuing.
9. Check Use Microsoft Update to check for updates. Click on Next.
10. Select the Setup Role you wish to install and click Next.
11. Select the features you wish to install and click Next.
12. If .Net Framework 3.5 is not installed, install it, and re-run the check.
13. Click Default instance. Click Next.
15. Choose the Account Name for each SQL Server service and click Next.
16. Select the Mixed mode radio button.
17. In the password field enter a password for the SQL Server system administrator (sa) account.
18. Click Add Current User. Then click on the Data Directories tab.
19. Change the Data root directory to the drive of the mirrored data partition.
20. Click Next.
21. There may be additional setup screens depending on what installation selections were made. Continue to the Ready to Install screen.
22. Click Install.
23. Click Close.
24. Close the SQL Server Installation Center.
25. Once the installation is complete click on Start > Programs > Microsoft SQL Server 2014 > Configuration Tools > SQL Server 2014 Configuration Manager. Expand SQL Server Network Configuration. Click Protocols for MSSQLSERVER.
26. Enable the Named pipes and TCP/IP protocols. Stop and restart the newly enabled services.

3.2 Installing SQL Server 2014 on Standby Server

Perform steps 1-29 in Installing SQL Server 2014 on Primary Server on the Standby Server
EXPRESSCLUSTER X Server Installation

4.1 Install EXPRESSCLUSTER X on the Primary Server (Machine 1)
1. Insert the EXPRESSCLUSTER X CD-ROM into a CD-ROM drive on the server.
2. In the pop-up window select NEC EXPRESSCLUSTER for Windows.
3. Click on NEC EXPRESSCLUSTER X 3.1 for Windows.
4. In the Welcome window, click Next.
5. In the Choose Destination Location window, click Next.
6. In the next window, click Install.
7. In the Port Number window, if necessary, modify the default port numbers. Click Next.
8. In the Filter Settings of Shared Disk window, click Next.
9. In the Confirmation window, click Yes.
10. In the License Manager window, click Register.
11. In the License Registration window, click Register with License Information.
12. In the Product Selection window, select the OS and Product/Trial types. For Product Name, click EXPRESSCLUSTER X 3.x for Windows. Click Next.
13. In the License Unit Selection window, depending on the type of license, enter the number of CPU or Node Units. Click Next.
14. In the License Key Entry window, enter the Serial No. and License Key. Click Next.
15. In the License Registration Confirmation window, confirm the information entered is correct. Click Next.
16. Click OK. If the license registration fails, start again from step 10.
17. Repeat steps 10-16 again for the EXPRESSCLUSTER X Replicator 3.x for Windows product license. Select EXPRESSCLUSTER X Replicator 3.x for Windows as the Product Name in step 12.
18. In the next window, click Finish.
19. On the InstallShield Wizard Complete window, click the No, I will restart my computer later option button, and then click Finish.
20. In the next window, click Exit. Click Exit. (Two times total).

4.2 Install EXPRESSCLUSTER X on the Standby Server (Machine 2)
Perform the steps 1-20 in Install EXPRESSCLUSTER X on the Primary Server (Machine 1) on the Standby Server (Machine 2).

4.3 Restart the Primary and Standby Servers (Machines 1 & 2)
First restart the Primary Server and then restart the Standby Server.
5 Base Cluster Setup
This section describes the steps to create a cluster using EXPRESSCLUSTER Manager running on the Management Console/Test Client (Machine 3).

5.1 Install Java Runtime Environment (JRE)
Verify JRE v.1.5.0.6 or newer is installed on the Management Console/Test Client (Machine 3). If necessary, install JRE by performing the following steps:

1. Run `jre<build and platform version>.exe` (a compatible JRE distribution can be found in the `jre` folder on the EXPRESSCLUSTER CD).
2. On the License Agreement screen, verify the default Typical setup option button is selected. Click Accept.

5.2 Start the cluster manager
The Cluster Manager is started by accessing port 29003 from the web browser of any of the nodes (Machine1 or Machine 2). Example: http://localhost:29003.

5.3 Create a cluster
For all of the steps below, refer to Table 1 for the IP addresses and Server names.

1. When the cluster manager is opened for the first time, there is a pop up with three options. Click "Start cluster generation wizard".
2. In the new window, type a Cluster Name. (Example: cluster).
3. Type the Management IP Address, and click Next.
4. In the next window, the server on which the cluster creation has started is already added. Click Add to add another server to this cluster.
5. Type the hostname or the IP address of the second server and click OK.
6. Both servers are now on the list. If the Primary Server is not in the top (Master) Server position, then move it up. Click Next.
7. EXPRESSCLUSTER X automatically detects the IP addresses of the servers. Select the network to use the Heartbeat path as Kernel Mode. Set the network for Mirroring by selecting Mirror Communication for the type and MDC as mdc1. Click Next.
8. For this guide, the NP Resolution resources are not configured. Click Next.

5.4 Create a failover group
For all of the steps below, refer to Table 1 for the IP addresses and Server Names.

1. To add a group, in the Cluster Generation Wizard, in the Group section, click Add.
2. In the next window, select failover for group type. Name the group (Example: SQL_Failover). Click Next, and then click Next.
3. Select the default options for the Group Attribute Settings, and then click Next.

5.5 Create floating IP and mirror disk resources
1. In the Group Resource section of the Cluster Generation Wizard, to add a resource, click Add.
2. In the next window, to add a Floating IP Resource (FIP), select floating ip resource from the drop down list. Click Next.
3. By default, the FIP resource is not dependent on any other resources. Follow the default dependency and click Next.
4. Use the default options and click Next.
5. Type a floating IP address that is not used by any other network element. Click Finish.
6. Click Add to add a mirror disk resource.
7. Click Get License Info to retrieve the active license for replication.
8. To add a Mirror Disk Resource (MD), select mirror disk resource from the drop down list. Click Next.
9. Verify the Follow the default dependency box is selected and click Next.
10. Use the default options and click Next.
11. Add both of the servers one by one. Click Add to add the first server. In the Selection of partition window, click on the Connect button to refresh the partition information. Select the Data and the Cluster partitions and click OK.
12. Repeat step 11 for the second server.
13. Click Finish.
14. Click Add to add a Virtual Computer Name.
15. Select virtual computer name resource from the drop down list. Click Next.
16. Click Next to Follow the default dependency.
17. Click Next.
18. Enter a Virtual Computer Name (Example: vsql) and select the %fip resource% that was created previously. Click Finish. Click Finish. (Two times total).
19. Click Next.
20. All the monitor resources are added automatically. Click Finish to add the monitors.

5.6 Upload the cluster configuration and initialize the cluster
1. In the Cluster Manager window, to apply the configuration, click the File menu and then click on Apply the Configuration File. Click OK. Click OK. (Two times total).
2. After the upload is complete, change to Operation Mode.
3. Restart Cluster Manager. Click the Service menu, and then click Restart Manager. Click OK.
4. Click the Service menu and click on Start Cluster. Click OK.
5. In the Cluster Manager window, in the left pane, expand the %failover group% section, right click %mirror disk%, and click Details. Mirror disk copy starts automatically, replicating data from the Primary to the Standby server. The copy screen would be similar to the following snapshot.

![Mirror Disk Helper](image)

**Note**
This step may take a while depending on the size of the data in the mirrored disk data partition.

6. After the copy is completed, the following screen is displayed:

![Mirror Disk Helper](image)

7. Click the Close button on the Mirror Disk Helper window.
8. In the Cluster Manager window, all icons in the tree view are now green. Refer to the figure below.
6 Microsoft SQL Server 2014 Cluster Setup

6.1 Moving the Master and Resource Database to Mirror Disk on Primary Server

**The following steps are only necessary if SQL Server is pre-installed on one of your systems. Otherwise the location of the data was already configured during SQL Server installation in Installing SQL Server 2014 on Primary Server.**

1. Create a new directory on the mirror disk: [your drive letter:]\MSSQL.
2. Inside MSSQL create another new directory: [your drive letter:]\MSSQL\DATA.
3. Click on Start > Programs > Microsoft SQL Server 2014 > Configuration Tools > SQL Server 2014 Configuration Manager.
4. Select SQL Server Services in the left panel, right-click on SQL SERVER (MSSQLSERVER), and click on Properties.
5. In the SQL Server (MSSQLSERVER) Properties dialog box, select the Startup Parameters tab.
6. Edit the Startup Parameters values to point to the planned location for the master database data and log files, and click OK when done. (Moving the error log file is optional.)

The parameter value for the data file must follow the –d parameter and the value for the log file must follow the –l parameter. The following example shows the parameter values for the default location of the master data and log files.

```
-dC:\Program Files\Microsoft SQL Server\MSSQL12.MSSQLSERVER\MSSQL\DATA\master.mdf;
-eC:\Program Files\Microsoft SQL Server\MSSQL12.MSSQLSERVER\MSSQL\LOG\ERRORLOG;
-lC:\Program Files\Microsoft SQL Server\MSSQL12.MSSQLSERVER\MSSQL\DATA\mastlog.ldf
```

If the planned relocation for the master data and log files is on the mirror disk: [your drive letter:]\MSSQL\DATA, the parameter values would be changed as follows:

```
-d[your drive letter:]\MSSQL\DATA\master.mdf; -eC:\Program Files\Microsoft SQL Server\MSSQL12.MSSQLSERVER\MSSQL\LOG\ERRORLOG; -l: [your drive letter:]\MSSQL\DATA\mastlog.ldf
```

7. Move the master.mdf and mastlog.ldf files to the mirror disk by using cut and paste. Any other databases must be detached, moved to the mirror disk with the accompanying log file, and attached.
8. Set all Microsoft SQL services to Manual and make sure that they are stopped.
6.2 Configure SQL Server 2014 on the Standby Server
   1. Move the cluster to the STANDBY server.
   2. Perform all of the steps in Moving the Master and Resource Database to Mirror Disk on Primary Server on the Standby Server (Machine 2) except Step 7.
   3. Move the cluster back to the PRIMARY server.

6.3 Create a SQL Server 2014 database on the Primary Server
   1. Click on Start > Programs > Microsoft SQL Server 2014 > SQL Server 2014 Management Studio. This launches the SQL Server Management Studio.
   2. Connect to the server.
   3. In the Object Explorer pane, expand the Databases folder. Right click on the Databases folder and select New Database.
   4. The New Database window is displayed. On the General page: In the Database name field, enter a name (this is the new database name and is case-insensitive)
   5. Deselect the Use full-text indexing check box.
   6. Set the Initial Size (MB) of the Database file to 50.
   7. Set the Initial Size (MB) of the Log file to 10.
   8. Click OK.

6.4 (Optional) Run Query Analyzer to test your database on the Primary Server

6.5 (Optional) Run Query Analyzer to test your database on the Standby Server
   In order to run this utility, the failover group has to be moved to the Standby Server.

6.6 Set the SQL Server Services
   After the SQL Server setup has completed on both servers, set all of the SQL Server Services to manual on the Primary and Standby servers, and make sure that they are stopped.

6.7 Cluster Services Setup
   1. In the Cluster Manager window change the View from Operation Mode to Config Mode.
   2. Right click on %failover group% and click Add Resource.
   3. Choose service resource for the Type.
   4. Enter a service name for the resource (Ex: MSSQLSERVER) and add optional comments if required. Click Next.
5. Choose to Follow the default dependency. Click Next. (To learn more about parameters please refer to the ExpressCluster X 3.x Reference Guide).
6. Click Next to accept the default values for Recovery Operation at Activity Failure Detection. (To learn more about parameters please refer to the ExpressCluster X 3.x Reference Guide).
7. Click on Connect and select the service SQL Server MSSQLSERVER from the drop down list.
8. Click Tuning. Set the START and STOP timeout values according to your requirements. The default value is 1800s. (To learn more please refer to the ExpressCluster X 3.x Reference Guide). Click OK.
9. Click Finish. Click OK on the warning dialog box.
10. Click the File menu and then click on Apply the Configuration File.
11. Click OK on all prompts to suspend and resume the cluster.
12. Change the view from Config Mode back to Operation Mode.

6.8 (Optional) Set up SQL Server monitor resource

Register ExpressCluster X Database Agent 3.x for Windows on Primary server.
1. Launch the License Manager within ExpressCluster (Start->Programs->NEC ExpressCluster Server->License Manager).
2. Click Register in the License Manager window to add the license.
3. On the License Registration window, select Register with License Information if entering the license key manually or select Register with License File if registering the license key via a file.
4. If registering with license file, copy the license file to a specific folder on the server.
5. On the License File Specification window, locate and select the license key file and click Open.
6. Click OK on the License Registration window.
7. Click Finish in the License Manager window.
8. Repeat steps 1 – 7 on the Standby server.

Add SQL Server monitor resource
1. In the Cluster Manager window change the View from Operation Mode to Config Mode.
2. Right-click on the Monitors folder and select Add Monitor Resource.
3. In the Monitor Resource Definition window, click the Get License Info button to retrieve the SQL Server database monitor resource license.
4. In the Monitor Resource Definition window, for Type, select SQL server monitor. Click Next. *Note that if SQL server monitor option is not available, repeat step 3 above.
5. By the Target Resource field, click the Browse button. Select the SQL server service resource (Example: MSSQLSERVER), and click OK. Click Next.
6. Set the Monitor Level as desired. Default is Level 2 (monitoring by update/select).
7. Enter the SQL **Database Name** to be monitored.
8. Set the **User Name** with an account with SQL Server administrative rights.
9. Click the Change button and enter the user **Password** and **Confirmation Password** in the dialog box.
10. The **Monitor Table Name** can be left as SQLWATCH or changed. *Note that this name should NOT be the same name as an existing table in your database as it is edited and may be deleted by ExpressCluster X during monitoring operations.
11. Select **SQL Server Native Client 11.0** from the dropdown list for the **ODBC Driver Name**. This is the driver used in SQL Server 2012 and SQL Server 2014. *Note that if an older version of ExpressCluster X does not have the version 11.0 option, the field is editable and can be changed.
12. Click **Next**.
13. Click the **Browse** button to set the **Recovery Target**. Select the SQL Server service resource under the `%failover group%` (Example: MSSQLSERVER). Click **OK**.
14. Click **Finish**.
15. Click the **File** menu and then click on **Apply the Configuration File**.
16. Click **OK** to confirm the operations to be performed.
17. Click **OK** to resume the cluster.
18. In the **Cluster Manager** window change the View from **Config Mode** back to **Operation Mode**.

To verify that your SQL Server database is being monitored, open the database to see if a new table exists with the name designated above.
Final Deployment in a LAN Environment

This chapter describes the steps to verify a LAN infrastructure and to deploy the cluster configuration on the Primary and the Standby server.

1. Configure and verify the connection between the primary and standby servers to meet the following requirements:
   - Two logically separate IP protocol networks: one for the Public Network and one for the Cluster Interconnect.
   - The Public Network must be a single IP subnet that spans the Primary and Standby servers to enable transparent redirection of the client connection to a single floating server IP address.
   - The Cluster Interconnect should be a single IP subnet that spans the Primary and Standby servers to simplify system setup.
   - A proper IP network between client and server machines on the Public Network on both the Primary and Standby servers.

2. Make sure that the Primary server is in active mode with a fully functional target application and the Standby Server is running in passive mode.

3. Ping both Primary and Standby servers from the test system and make sure that the Standby server has all the target services in manual and stopped mode.

4. Start the cluster and try accessing the application from the Primary Server. Then move the cluster to the Standby server. Check the availability and functionality of the application on the Standby Server after failover.

5. Deployment is complete.
8 Common Maintenance Tasks
This section describes how to perform common EXPRESSCLUSTER maintenance tasks using
the EXPRESSCLUSTER X WebManager.

8.1 Start Cluster Manager
There are two methods to start/access Cluster Manager through a supported Java enabled web browser. The first method is through the IP address of the physical server running the cluster management server application and the second method is through the floating IP address of the cluster management server within a cluster.

The first method is typically used during initial cluster setup before the cluster management server floating IP address becomes effective:
1. Start Internet Explorer or another supported Java enabled Web browser. Type the URL with the IP address of the active physical server followed by a colon and the cluster management server port number.

   Example:
   Assuming that the cluster management server is running on the active physical server (10.1.1.1) on port number 29003, http://10.1.1.1:29003/

2. The second method is more convenient and is typically used after initial cluster setup:
   Start Internet Explorer or another supported Java enabled Web browser. Type the URL with the cluster management server floating IP address followed by a colon and the cluster management server port number.

   Example: Assuming that the cluster management server is running with floating IP address (10.1.1.3) on port 29003, http://10.1.1.3:29003/

8.2 Reboot/shutdown one or all servers

8.2.1 Reboot all servers
   1. Start Cluster Manager. (refer to 8.1)
   2. Right-click the %cluster name% and click Reboot.
   3. In the Confirmation window, click OK.

8.2.2 Shutdown all servers
   1. Same as “Reboot all servers,” except in step 2, click Shutdown.

8.2.3 Shutdown one server
   1. Start Cluster Manager. (refer to 8.1)
2. Right-click the %machine name% and click Shutdown.
3. In the Confirmation window, click OK.

8.3 Startup/stop/move failover groups
1. Start Cluster Manager. (refer to 8.1)
2. Under Groups, right-click %failover group% and then click Start/Stop/Move.
3. In the Confirmation window, click OK.

8.4 Isolate a server for maintenance
1. Start Cluster Manager. (refer to 8.1)
2. In the Cluster Manager window, change to Config Mode.
3. Click the %cluster name% and then right-click Properties.
4. Click the Auto Recovery tab. If you would like to manually return the server to the cluster, select Off for the Auto Return option. Otherwise, leave it set to On for automatic recovery when the server is turned back on. Click OK.
5. If a change was made, upload the configuration file.
6. Shut down the machine that is the server you wish to isolate for maintenance.
7. The server is now isolated and ready for maintenance tasks.

8.5 Return an isolated server to the cluster
Start with the server that was isolated in the steps listed above ("Isolate a server for maintenance").

8.5.1 Automatic Recovery
1. Turn the machine back on.
2. Recovery starts automatically to return the server to the cluster.

8.5.2 Manual Recovery
1. Turn the machine back on and wait until the boot process has completed.
2. Start Cluster Manager. (refer to 8.1)
3. In the Cluster Manager window, right click the name of the server which was isolated and select Recover. The server which was isolated will return to the cluster.

8.6 Rebuild a mirror disk
1. Start Cluster Manager. (refer to 8.1)
2. In the Cluster Manager window, in the left pane, right-click Servers and then click Mirror Disks.
3. In the Mirror Disks window, click the **Details** button.
4. In the next window, click the button below the `%machine name%` of the machine you want to copy files from [Primary Server (Machine 1)] and then click the button below the `%machine name%` of the machine you want to copy files to [Standby Server (Machine 2)].
5. Click the **Execute** button. In the **Confirmation** window, click **OK**.
Appendix A: EXPRESSCLUSTER X Server Un-installation

Follow the steps below to uninstall EXPRESSCLUSTER X from each of the server systems.

1. On the Management Console/Test Client, in Cluster Manager, click the Service menu, and the click Stop Cluster.
2. Close Cluster Manager.
3. On the server system that you are starting the uninstall process for EXPRESSCLUSTER, stop all EXPRESSCLUSTER services. To stop all services, follow the steps below:
   - On the Start menu, point to Programs, point to Administrative Tools, and double-click Services.
   - In the right pane, scroll down and double-click the entry for EXPRESSCLUSTER. Click the Stop button.
   - In the Stop Other Services dialog box, click Yes. Click OK.
   - Repeat steps 3.b. above for the entry for EXPRESSCLUSTER EVENT, and then click OK.
4. On the Start menu, click Control Panel. Click Uninstall a program.
5. In the Uninstall or change a program window, click NEC ExpressCluster Server. Click the Uninstall.
6. In the Question window, click Yes to start the uninstall process.
7. In the next window, click Yes to reset the registry settings to disable the media sense functions of TCP/IP disconnect detection.
8. In the first Install Wizard Complete window, click Finish.
9. On the next Install Wizard Complete window, select the Yes, I want to restart my computer now option button. Click Finish.

This completes the uninstall process for an individual server system.

Note
You must be logged on as an administrator or an account with administrator privileges to uninstall Express Cluster Server.

If a shared disk is used, unplug all disk cables connected to the server after un-installation is complete.
Appendix B: Example System Planning Worksheet

Machine 1 Primary Server
Machine 2 Standby Server
Machine 3 Test client Machine

Table 1: System Network Interfaces

<table>
<thead>
<tr>
<th>Machine</th>
<th>Host name</th>
<th>Network Connection</th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Default Gateway</th>
<th>Preferred DNS Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Primary</td>
<td>Public Interconnect</td>
<td>10.1.1.1</td>
<td>255.255.255.0</td>
<td>10.1.1.3</td>
<td>10.1.1.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>192.168.1.1</td>
<td>255.255.255.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Standby</td>
<td>Public Interconnect</td>
<td>10.1.1.2</td>
<td>255.255.255.0</td>
<td>10.1.1.3</td>
<td>10.1.1.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>192.168.1.2</td>
<td>255.255.255.0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 2: System OS and Disks

<table>
<thead>
<tr>
<th>Machine</th>
<th>OS</th>
<th>Disk 0 (OS Disk)</th>
<th>Disk 1 (Data Disk)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Windows Server 2012 R2 (Standard or Enterprise) with latest update</td>
<td><strong>Boot Partition</strong>: Drive Letter: C Size: 75GB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Windows 7 or later</td>
<td>C: 20 GB</td>
<td></td>
</tr>
</tbody>
</table>

* Must be a raw partition and larger than 17MB.

Floating IP (FIP) addresses:
Web Management Console FIP: (1) 10.1.1.4

Table 3: System Logins and Passwords

<table>
<thead>
<tr>
<th>Login</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Administrator</td>
</tr>
<tr>
<td>Machine</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Administrator</td>
</tr>
</tbody>
</table>